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Getting Started

System Requirements

Macintosh Minimum
•  PowerPC processor

• Apple System Software 7.1.2

• 16 Megabytes of physical RAM

• Color monitor with 8-bit or greater video card

Macintosh Recommended
• PowerPC processor

• Apple System Software 7.5 or later

• 32 Megabytes of physical RAM

• Color monitor with 24-bit video card

Windows Minimum
• 486/DX processor

• Windows 95

• 16 Megabytes of physical RAM

• Color monitor with 8-bit or greater video card.

Windows Recommended
• Pentium processor

• Windows 95, 98 or NT 4

• 32 Megabytes of physical RAM

• Color monitor with 24-bit video card

Welcome to Xenofex 1.0, a set of 16 plug-in filters
that let you create amazing special effects quickly
and easily.

Like all Alien Skin Software products, Xenofex is
designed to be extremely easy to use.  We do
encourage you to read through this manual at least
once, since it’s possible that you’ll overlook some
powerful ways to use  the filters if you don’t check
their descriptions.  Also, some filters work better on
certain types of objects; be sure to check the
chapters on specific filters if you’re having trouble
getting a desired effect.

We also suggest that you carefully read pages 8
through 15; they cover installation instructions and
features common to all 16 Xenofex filters.  Take a
few minutes to familiarize yourself with the
preview window, learn to use the presets and create
your own settings, and you’ll quickly be ready to
dive in and experiment with the special effects.

Host Requirements
You must use Xenofex with one of the following
programs:

Macintosh
Adobe Photoshop 3.0.4 or later (we recommend 4.0

or later)

Adobe Image Ready 1.0

Corel Photo-Paint 8

MicroFrontier Enhance 4.01

MicroFrontier Digital Darkroom 1.2

Windows
Adobe Photoshop 3.04 or later (we recommend 4.0

or later)

Jasc Paint Shop Pro 4.12 or later

Corel Photo-Paint 7 (Revision B and 7.663) and
Photo-Paint 8

Adobe Image Ready 1.0

CiEBV PhotoLine 32 (version 4.52 or later)

SPG ColorWorks:WEB 3 (version 3.004 or later)

MicroFrontier Digital Darkroom 1.2

Micrografx Picture Publisher 8

Microsoft Image Composer 1.5 or later

Please note: We are constantly testing new pro-
grams for compatibility with our plug-ins.  For
information about any host program not listed
above, please check our web site.
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Macintosh Installation
Start by making sure you are not running your
graphics program (Photoshop, Enhance, Photo-
Paint, etc.).  This is necessary because these
programs only recognize new filters when starting
up.

Insert the Xenofex disk into your computer.
Double-click  the “Install Xenofex” icon.  After the
splash screen, the installer will display the license
agreement for Xenofex.  Click Yes  after you have
read the agreement to agree with its terms.  The
installer will then display any new information or
changes to the installation instructions.  After
reading this, click Continue.

Next you will be asked to enter your name,
company name (optional) and registration code.

Your registration code is the 12-letter code located
on a sticker attached to the CD case.  We strongly
suggest you write this code in the manual or store
it in a safe place for future installations.

Now you will see the main installation screen,
which should look like the image at the top of the
next column.

Main installation screen for Xenofex

It is important that you locate your graphics
program’s plug-in folder.  If you do not choose the
proper plug-in folder, then the filters will not show
up in your graphics program’s Filter menu.

Browse your hard disk until you find the appropri-
ate Plug-ins folder.  Highlight the folder and click
the Install into...  button to return to the main
installation screen.  The Xenofex files will be copied
to your hard disk.

If you are not sure where to install Xenofex, consult
your graphics program’s manual.  Photoshop users
can check for the plug-in location by selecting the
Plug-In option under the Preferences sub-menu of
Photoshop’s File menu.  It is usually located in the
Photoshop folder.

Windows Installation
Start by making sure you are not running your
graphics program (Photoshop, Paint Shop Pro,
Photo-Paint, etc.).  This is necessary because these
programs only recognize new filters when starting
up.  Your copy of Xenofex may be bundled with
Paint Shop Pro 4.15 SE; you can easily install both
of these programs at the same time.  Users of Paint
Shop Pro 4.12, PSP 4.14 or PSP 5 please refer to
page 10 for important setup instructions.

Insert the Xenofex disk into your computer.
Double-click on the SETUP.EXE program.  After the
splash screen, the installer will display the license
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agreement for Xenofex.  Click Yes  after you have
read the agreement to agree with its terms.  The
installer will then display any new information or
changes to the installation instructions.  After
reading this, click Continue.

Next you will be asked to enter your name,
company name (optional) and your registration
code.

Your registration code is the 12-letter code located
on the CD case.  We strongly suggest you write this
code in the manual or store it in a safe place for
future installations.

A dialog will appear, asking if you want the
installer to find the Photoshop plug-in folder.  If
you are using Photoshop 3.04 or later, click Yes.  If
you are using another image editor, click No to
manually select the plug-in folder.

If you clicked Yes, the setup program will make a
guess at the location of Photoshop’s plug-in folder.

Once it finds a plug-in folder, it will ask if you
would like to install Xenofex in that location.  If it is
appropriate, click Yes.  If not, clicking No continues
the search for another plug-in folder.

Eventually, if the installer can find no more
Photoshop plug-in folders, it will prompt you to
select the folder.  Browse through the file list until
you find the desired folder and click OK.  If you are
not sure where to install Xenofex, consult your
graphics program’s manual.  Photoshop users can
check for the plug-in location by selecting the Plug-
In option under the Preferences sub-menu of the
File menu.
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Two: Run the Xenofex setup program.  When
asked, don't let Xenofex search for the Photoshop
plug-in folder; instead, browse and find the correct
Paint Shop Pro plug-in folder.  The default location
for Paint Shop Pro 4 is C:\Program Files\Paint
Shop Pro\Plug-Ins.  The default location for Paint
Shop Pro 5 is C:\Program Files\Paint Shop Pro
5\Plug-Ins.

Three: Run Paint Shop Pro.  Select
"Preferences:General Program Preferences" from
under the "File" menu.  Click on the "Plug-in
Filters" tab of the Preferences dialog window.
Check the "Enable Plug-In filters" checkbox.  Use
the Browse button to pinpoint the Plug-in folder.
When you have located the appropriate Plug-in
folder, click "OK" to exit the Preferences dialog.

This is the Preference dialog for Paint Shop Pro 4.

This is the Preference dialog for Paint Shop Pro 5.

The filters will appear under Image> Plug-in
Filters> Xenofex 1.0.

Registration
Make sure that you take time to register your copy
of Xenofex with us.  Of course, you must register to
receive technical support.  Once you register, we’ll
be able to notify you immediately of bug fixes and
updates, as well as special discounts on other Alien
Skin products.

You can register at our web site:

http://www.alienskin.com

A registration card is also included with the
software in case you don’t have World Wide Web
access; just mail or fax the completed card to us and
we’ll register you.

Please note that if you purchased Xenofex directly
from Alien Skin Software, then you are already
registered.  You only need to register if you
purchased Xenofex through a catalog, store or other
reseller.

Installation Instructions for Paint
Shop Pro Users
Your copy of Xenofex may be bundled with Paint
Shop Pro 4.15 SE; you can easily install both of
these programs at the same time.  However, users
of Paint Shop Pro 5 or other versions of PSP 4 will
need to follow the instructions below.

Since Paint Shop Pro doesn’t ship with a built-in
Plug-ins folder, you will have to create one and let
Paint Shop Pro know where it is located.  You can
do this in three easy steps:

One:  Create a "Plug-ins" folder in the Paint Shop
Pro folder.
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Apply and Cancel Controls
Located in the upper right hand corner of the filter
dialog box are two buttons:

 Click this checkmark button to apply the
filter with the current settings.

 Click this  cancel button to exit the filter
without applying the effect.  Note that hitting the
Escape key does the same thing.

Preview Controls
The bottom half of each Xenofex filter dialog box is
devoted to previewing.  The large area at the lower
right is the Preview window, which shows how the
special effect you’ve chosen will be applied to your
image.  You can preview different parts of your
image by dragging the preview with the mouse.
You can also resize the Preview window to make it
larger or smaller by clicking on its lower right
corner and dragging your mouse.

Thumbnail Navigator Window
At bottom center is a Thumbnail, a small copy of
your entire image.  A small black rectangle in the
Thumbnail represents the view of the Preview
window.  You can move the Preview area by
dragging the black rectangle with the mouse.  You
can also click outside the rectangle in the Thumb-
nail and the rectangle will jump to that area.

Zoom Buttons
You can zoom into and out of the preview with the
buttons above the Thumbnail.  Zoom Out is on the

left; Zoom In is on the right.  You can view pre-
views at zoom percentages from 6% to 1600%.

Preview Progress Indicator
Between the Zoom Out and Zoom In buttons is the
Preview Progress Indicator field.  This field will
always be one of three colors: Green means that the
image displayed in the Preview window is up to
date (i.e., the Preview Window reflects your current
filter settings).  Yellow means that a preview image
is currently being generated.  Red means that the
Auto Preview feature (see below) has been dis-
abled, and what you see in the Preview window
may not reflect your current filter settings.  The
Preview Progress Indicator field also displays the
current zoom percentage of the Preview window.

Auto Preview
If the Auto Preview button is enabled (filled with
blue), every time you move a slider or click a
button in the filter dialog box, the Preview will
update itself.  You don’t have to wait for a preview
to finish updating before you move a slider again
or click another button.  If you do not want
previews to be constantly updated, uncheck the
Auto Preview button.  If you do this, you will have

to click the Preview Now button
(the stylized eye just below Auto
Preview) in order to update the
preview image to reflect your
current filter settings.

Clicking the Alien
Clicking the alien icon in the lower left corner of
our filter dialog box will bring up the About Box,
where your registration information is listed.  There
is also a button labeled “Go to Alien Skin’s web
site.”  If you have a web browser installed on your
computer, clicking on this button will start your
web browser and take you to our home page.
Warning! Clicking the button will exit you out of
the filter.
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Using Presets and Saving/Deleting
Settings
To help you get started quickly, each filter in
Xenofex comes with presets.  You have over 160
preset effects at your disposal even before you start
experimenting.  To load a filter’s presets, run the
filter, then click on the Settings pop-up menu
directly above the Preview window and select the
preset you want to try.

 

Selecting a particular setting allows you to preview
the effect (see Preview Controls on page 11).  If you
like a particular preset effect, take time to note
values of the filter’s sliders, so you can get a better
understanding of what each filter is capable of.

You can easily create and name your own settings
and add them to the list of presets.  To save your
current settings for future use, select “Save...” from
the Settings pop-up menu.  Type in the name you
want to use for this setting and click OK.

From now on, that name will appear in that filter’s
Settings pop-up menu.  To load old settings, simply
select them as you would one of the presets.

Note: The settings called “Last Used” are automati-
cally generated every time you click the OK button.

Deleting a setting is just as easy.  When you select
“Delete...” from the Settings pop-up menu, you will
be asked to choose your victim from the list of
names.

Clicking “Delete” removes that setting from that
filter’s Settings pop-up menu.  It will not appear
again unless you recreate it.

Note: You cannot delete the “Last Used” setting.

Selections
Most paint programs have powerful selection
capabilities and we have tried to build on these
features by taking selection shape into account
when designing our filters.  Using selections will
almost always give you the maximum benefit from
Xenofex’s filters.  Also, be sure to read the chapter
on Selections in your Photoshop manual (Chapter 4
for Photoshop 3 users and Chapter 7 for Photoshop
4 and 5 users).

Please note that all of the filters in Xenofex that use
selections will also work in layers with no selec-
tion.  Using a layer is usually much easier than
creating a selection.  It also has the advantage of
allowing you to move the affected area after the
filter has been applied.  See the next section on
Layers for more information about this option.

Important Note For Paint Shop Pro 4.15 Users:
Floating Selections

When you create Type or Cut and Paste, Paint Shop
Pro 4.15 will float your selection. It is important
that you Defloat the selection before applying the
following filters: Electrify, Flag, Shatter, Crumple,
Shatter, Distress, Stamper and Television.  These
filters behave unpredictably on floating selections.
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To Defloat the selection,  use Selections>Defloat or
Ctrl-D.

For users of Photoshop 3.04 or 3.05
If you use floating selections in Photoshop 3, we
recommend that you defloat your selection by
placing it in a layer by itself before applying our
filters.  Xenofex will behave unpredictably on
floating selections.

The Electrify filter draws outside of the selection.
In Photoshop 3.04 and 3.05, this means that you
will lose your selection if you have not saved it
before applying this filter.  Don’t forget to save
your current selection if you will need to use it after
applying Electrify.

Photoshop Layers
A layer is like an extra image on a piece of clear
glass over your background image.  Layers allow
you to keep your composition flexible until you’re
sure where you want to place all of your image
components.  Most of Xenofex’s filters take
advantage of this layer technology.  For more
information about Photoshop’s layer capabilities,
consult your Photoshop manual (Chapter 8 for
Photoshop 3 users, Chapter 11 for Photoshop 4 and
5 users)

All of our filters can be used in layers.  More
importantly, many Xenofex filters actually affect
transparency when used in a layer.  This means, for
instance, that you can use Electrify to create electric
bolts around an alien in a layer, then move the alien
and bolts together without affecting the rest of your
image.  If you drop the alien onto the background
and apply Electrify there, then you can’t move the
electric alien without leaving a hole in the back-
ground.

IMPORTANT!  To ensure that our filters work
correctly in a layer, make sure that the Preserve
Transparency checkbox is not checked.

The Xenofex filters will behave unpredictably or
have no effect when Preserve Transparency is
enabled.  Note that Photoshop 4 automatically
enables Preserve Transparency when it creates type
and when it places an image in a layer.  Disable it
and you will be able to use our filters without a
problem.  Unfortunately, a filter only has access to
one layer at a time.  That means that when you
work with a floating selection or a layer, the
preview will not be able to show you the entire
image composition.  Wherever the layer is transpar-
ent, the preview will show a checkerboard pattern
(see below).

One final note about
layers, selections and
our filters:  If you are
working with an object
in its own layer, you
don’t really need a
selection, because the
filter can figure out the
shape of your object by
looking at which parts
of the layer are opaque.

Photoshop 5’s Type Layer and Xenofex
Adobe Photoshop 5 allows users to create a special
dynamic kind of layer.  While working with a type
layer, you will notice that all of the Filters are
grayed out.  In order to use filters on those layers,
you will need to first render the layer.  Rendering
the layer will convert the type to pixels.  To render
the layer, select the type layer and choose
Type>Render Layer from the Layer menu.  After
rendering a type layer, you will be able to apply
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our filters, but the type will no longer be editable
(this is built into Photoshop 5).  More information
about Type Layers can be found in Chapter 12 of
the Adobe Photoshop 5 manual.

Actions In Photoshop 4 and 5
Photoshop 4.0 introduced the ability to group a
series of tasks into one automated single command,
or Action.  Xenofex’s filters were designed to take
advantage of this powerful new feature.  All of the
filters in Xenofex fully support Actions in
Photoshop 4 and 5.  For more information on how
to use Actions, consult your Photoshop manual
(Chapter 15 for Photoshop 4, Chapter 16 for
Photoshop 5).

Xenofex and Image Modes
All Xenofex filters fully support Grayscale,
Duotone, RGB, CMYK and Multichannel modes.

The following filters will work in Lab mode:
Distress, Electrify, Lightning, Origami, Shatter,
Shower Door and Stain.

Current Photoshop plug-in specifications do not
allow any filters to work in Bitmap or Indexed
Color modes.

If a filter will not work in a given mode, its name
will appear grayed-out in the Filter menu.
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The Filters

Getting to know Xenofex

All 16 Xenofex filters are extremely easy to use.  To
get the most practical and enjoyable results from the
software, we recommend you read over each filter’s
description in this manual and take a few moments
to experiment with the presets found in each filter’s
Preview window.

Some of the more interesting effects possible with
Xenofex may not be obvious at first glance.  For
instance, it’s possible to get realistic burned edges
using the Stain filter (see page 43), hard plastic
surfaces and wet intestinal tracts using Little Fluffy
Clouds (page 30), scaly reptile skin using Baked
Earth (page 16) and blood vessels or capillaries
using Lightning (page 28).  Both the filter descrip-
tions in the following chapters and the presets
included with the software are useful for discover-
ing these possibilities.

Other important information is included in each
filter’s description.  Stamper, for instance, allows
you to choose your own file to create a mosaic effect,
but the Stamper description points out that the file
must be an uncompressed TIFF image, and lists
certain restrictions on the image mode (see page 44
for full information about Stamper).

Of course, the best way to get to know the Xenofex
filters is to experiment with them yourself.  Take the
time to read the descriptions we provided, use the
presets to familiarize yourself with what the sliders
in the Preview window can do, and then experiment
on your own artwork.

Enjoy!

Specialized Filters and Selections

Most of the filters in Xenofex work well with or
without selections, in the background layer or in a
layer with transparency.  However, three of the
filters were created for use in special situations:

Electrify

This filter draws bolts of electricity around the
outside of an object.  It thus requires a selection.  It
can be run on an object by itself in a layer, but only
if the object does not occupy the entire layer.

Distress

This filter was created specifically for use on an
object, like thick text, in a layer with transparency.
If you use it on an object that is surrounded by color
information instead of transparency, you may get
confusing results.

Stain

This filter was created for use with selections; if you
don’t make a selection, the Stain will cover your
entire layer and the effect will not be as noticeable.

Please refer to the specific chapters about these
filters for more information.
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Baked Earth uses shadows and highlights to create
the appearance of dried and cracked earth over
your selection.  A wide range of realistic textures is
possible.

Baked
Earth

Controls

Crack Length
Controls the length of the cracks between the
chunks of earth, which also controls the size of those
chunks.  Larger values produce longer cracks.

Crack Width
Controls the width of the cracks between the pieces
of earth.

Variation
Controls the roughness of the outer edges of the
chunks of earth; higher values yield a rougher, more
eroded look.

Random Seed

Controls the random element in the creation of this
effect.  Minor changes in the Random Seed slider
can produce dramatic changes in your image, and
we encourage you to experiment with this control
until you find the effects you like best.  You will
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then be able to precisely duplicate them by noting
the Random Seed setting.

Highlight Brightness and Highlight Sharpness
Control the white highlights that appear on those
parts of your selection facing the light.  Brightness
controls the intensity of these highlights, while
Sharpness affects their diffusion.  Higher values
yield a glossier effect.

Lighting Direction
Controls the direction from which the light falls on
your selection.  You have a full 360° range from
which to choose.  A value of 0° yields light directly
from the right; 90° yields light from the top; 180°
yields light directly from the left, and 270° yields
light from the bottom.

Lighting Inclination
Controls the angle formed by the light and the
page.  This gives the effect of more depth.  If the
light originates from directly overhead, the light
angle will be at 90°.  As the light comes more
directly from the side, the value will approach 0°.

Note that you can control the lighting by
clicking anywhere in the Lighting box or by
entering numeric values for Direction and
Inclination.

Baked Earth applied with small Crack Length and small Crack
Width to create a cracked and peeled paint effect

Baked Earth can simulate skin or a scaly, reptilian hide by
moving the light to the bottom right, using low Variation

Pebble-like effects are possible with very low Crack Length and
Crack Width and high Variation
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Constellation

Constellation recreates your image as points of
light.  Each point of light is the color of the original
image at that point.

Constellation is meant for use primarily on color
images, because each star gets its color from the
color of the original image where it is placed.  Also,
the Overdrive parameter makes the center of each
star white, which simulates light that is so intense
that it overexposes film or overloads the cells in the
human retina.  In grayscale images, this whitening
isn’t noticeable, which is another reason we
recommend sticking with color images for this
filter.

When used in the background layer, Constellation
uses your background color to fill in the gaps
between stars.  When used in a layer other than the
background, the space between stars is transparent.

Constellation can also provide a wide range of
kaleidoscopic textures and effects; we strongly
recommend you experiment with this filter, starting
with the presets, to discover what it can do.

Controls

Star Size
Controls the radius of the stars that make up your
constellation.  The higher the setting, the fewer the
stars.

Sharpness
Controls the blurredness of the stars.  Higher
settings yield pinpoint stars, while lower settings
produce a softer disk of light.

Overdrive
Controls the brightness and saturation of the stars’
light and color.  Higher values make the stars
brighter and whiter.
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Random Seed

Controls the random element in the creation of this
effect.  Minor changes in the Random Seed slider
can produce dramatic changes in your image, and
we encourage you to experiment with this control
until you find the effects you like best.  You will
then be able to precisely duplicate them by noting
the Random Seed setting.

Constellation applied to an image (top) with increasing
Sharpness values (bottom).  Highest Sharpness is on the right.
This was done in a layer on top of another copy of the original.
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Crumple

Crumple simulates the effect of printing the image
on paper that has been crushed and then partially
flattened out again.

Controls

Crinkle Size
Controls the size of the creases in the crumpled
paper.

Distortion
Low values flatten the paper more; higher values
leave the paper more wrinkled and pulled away
from the edges of the image.  Note that highly
crumpled paper covers less projected area than the
original sheet; this means that if you use Crumple
with high Distortion on a selection in your back-
ground layer, there may be areas where your
background color will be visible.

Random Seed

Controls the random element in the creation of this
effect.  Minor changes in the Random Seed slider
can produce dramatic changes in your image, and
we encourage you to experiment with this control
until you find the effects you like best.  You will
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then be able to precisely duplicate them by noting
the Random Seed setting.

Light Boost
Increases the overall brightness of the image to
compensate for any darkening due to lighting
calculations.

Highlight Brightness and Highlight Sharpness
Control the white highlights that appear on those
parts of your selection facing the light.  Brightness
controls the intensity of these highlights, while
Sharpness affects their diffusion.  Higher values
yield a glossier effect.

Lighting Direction
Controls the direction from which the light falls on
your selection.  You have a full 360° range from
which to choose.  A value of 0° yields light directly
from the right; 90° yields light from the top; 180°
yields light directly from the left, and 270° yields
light from the bottom.

Lighting Inclination
Controls the angle formed by the light and the
page.  This gives he effect of more depth.  If the
light originates from directly overhead, the light
angle will be at 90°.  As the light comes more
directly from the side, the value will approach 0°.

Note that you can control the lighting by
clicking anywhere in the Lighting box or by
entering numeric values for Direction and
Inclination.

Crumple applied to a layer filled with white and type.  Crinkle
Size is low and Distortion is medium.

Crumple applied to type in three separate layers, with
increasing Distortion

Crumple applied to a two-dollar bill that has been duplicated in
separate layers.  Crinkle Size and Distortion were varied for
each layer and shadows were added for depth.
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Distress

Distress creates an organic aging and crumbling
effect, as if something has been eating away at the
edges of your selection.

Distress works by pulling surrounding color into
the selection.  This means that you’ll get the best
effect by using this filter on an object, like thick
text, surrounded by transparency (that is, placed in
a layer such that there is no color information
immediately around the text).  Distress sucks in the
transparency, thus eating away at the edges of the
object.  If you use Distress on an object that is
surrounded by color information instead of
transparency, you may get confusing results.

Please take a look at the example images included
on the next page to see how to make best use of this
filter.

Controls

Edge Width
Controls the width of the distress around the edges
of your selection; higher values cause more erosion.

Irregularity
Controls the shape of the crumbling effect; higher
values yield a more odd, irregular erosion.

Edge Type
There are three types of edge available; Lumpy
produces a more rounded effect, while Rough and
Jagged produce sharper, more chipped erosion.
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Top to Bottom: Lumpy, Rough and Jagged Edge Type, with
Edge Width set at 20 and Irregularity at 50 each time

A circle, enlarged, with the three Edge Types applied and other
settings kept constant.

Here, the same Edge Type but with increasing Edge Width,
which eats away more of the selection.

Distress can also be used to create interesting edges around
photo images.

How not to use Distress.  The Cactus was selected and Distress
applied with high Edge With and Irregularity.  Note that the
filter pulled color information into the selection, rather than the
transparency it needs to create its eroding effect.  Putting
objects in their own layer before applying Distress is almost
always the best choice.
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Electrify

Electrify creates bolts of electricity branching out
from the edges of your selection.  You have a wide
range of control over the number, shape and color
of the bolts of electricity.

Since this filter draws bolts of electricity around the
outside of an object, it must have a selection, or be
run in a layer on an object that doesn’t occupy the
entire layer, in order to work.

For users of Photoshop 3.04 or 3.05:  The Electrify
filter draws outside of the selection.  In Photoshop
3.04 and 3.05, this means that you will lose your
selection if you have not saved it before applying
this filter.  Don’t forget to save your current
selection if you will need to use it after applying
Electrify.

Controls

Arc Length
Controls the length of the bolts of electricity.
Higher values yield longer bolts.

Arc Spacing
Controls how far the bolts are from one another.
Higher values mean fewer bolts.

Segment Length
Controls the length of each segment along the bolts.
Higher values make the bolts of electricity appear
more jerky and angular.

Glow Width
Controls the width of the outer color’s glow; higher
values increase the glow size.
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Inside Masking

Controls how much the effect is visible inside your
selection.   Higher values cut off the effect more
sharply at the selection edge.

Jaggedness
Controls the variation in the direction of the
segments along each bolt.   Lower values produce
straighter bolts.

Meander
Controls the curve of the path each bolt follows.
Higher values produce a more curved path,
especially with high Jaggedness and low Segment
Length settings.

Branching
Controls the number of branches each bolt forms;
higher values generally yield more branching.
Because branching is a random process, changing
the Branching slider will sometimes have no effect
and sometimes have a large effect.    Tweaking
Random Seed will sometimes create more branches
when Branching doesn't seem to have much effect.

Branch Spread
Controls how far apart the branches are spaced;
higher values increase the angle between branches.

Random Seed

Controls the random element in the creation of this
effect.  Minor changes in the Random Seed slider
can produce dramatic changes in your image, and
we encourage you to experiment with this control
until you find the effects you like best.  You will
then be able to precisely duplicate them by noting
the Random Seed setting.  Electrify has many
components based on random factors, so this
control is particularly important here.

Inner and Outer Color
The glow at the middle of each bolt starts as the
Inner Color and fades to the Outer Color as it
moves outward.    Clicking in either box brings up
the color picker you have previously selected in
your graphics program.

Electrify applied with a medium Segment Length and medium
Branching

Segment Length set very low and both Jaggedness and Meander
set very high.   Note in the bottom image that shrinking the
selection a bit and applying Electrify again yields bolts of
electricity coming from inside as well as outside the image.
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Flag

Flag provides realistic 3-D rendering of rippling
surfaces, adding shadows and highlights to create a
windblown banner effect.  It works best on an
object that is by itself in a layer with transparency.

Controls

Ripple Thickness
Controls the width of the ripples added to your
selection; higher values yield fewer, thicker ripples

Ripple Strength
Controls the depth and distortion of the ripples;
higher values yield a stronger rippled effect.

Random Seed

Controls the random element in the creation of this
effect.  Minor changes in the Random Seed slider
can produce dramatic changes in your image, and
we encourage you to experiment with this control
until you find the effects you like best.  You will
then be able to precisely duplicate them by noting
the Random Seed setting.
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Light Boost
Increases the overall brightness of the image to
compensate for any darkening due to lighting
calculations.

Highlight Brightness and Highlight Sharpness
Control the white highlights that appear on those
parts of your selection facing the light.  Brightness
controls the intensity of these highlights, while
Sharpness affects their diffusion.  Higher values
yield a glossier effect.

Lighting Direction
Controls the direction from which the light falls on
your selection.  You have a full 360° range from
which to choose.  A value of 0° yields light directly
from the right; 90° yields light from the top; 180°
yields light directly from the left, and 270° yields
light from the bottom.

Lighting Inclination
Controls the angle formed by the light and the
page.  This gives the effect of more depth.  If the
light originates from directly overhead, the light
angle will be at 90°.  As the light comes more
directly from the side, the value will approach 0°.

Note that you can control the lighting by
clicking anywhere in the Lighting box or by
entering numeric values for Direction and
Inclination.

Flag applied to a pennant-shaped solid in its own layer, with
Ripple Thickness and Ripple Strength set at medium values

Flag applied to four different layers, with increasing Ripple
Strength

This towel effect was created by making a rectangular selection
in a layer and filling it with a texture, some type and a
handprint.  Next, the selection was rotated 180° and duplicated.
Flag was applied to both layers, and the lower layer was
darkened.
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Lightning

Lightning draws a glowing lightning bolt across
your selection.   You can easily control the length,
branching, spread and color of the lightning.  If you
do not make a selection, Lightning will appear
across the entire image.

Please note that the amount of branching of the
Lightning is a random process controlled by the
Branching, Branch Spread and Random Seed
sliders.  This means that a small change made to
one of those controls may have a large and unpre-
dictable effect on the number and distribution of
lightning branches.

Controls

Segment Length
Controls the length of each segment along the bolts.
Longer segments make the lightning appear more
jerky and angular.

Glow Width
Controls the width of the outer color’s glow; higher
values increase the glow size.

Jaggedness
Controls the variation in the direction of the
segments along each bolt.  Lower values produce
straighter bolts.

Meander
Controls the curve of the path each bolt follows.
Higher values produce a more curved path,
especially with high Jaggedness and low Segment
Length settings.
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Branching
Controls the number of branches each bolt forms;
higher values generally yield more branching.
Because branching is a random process, changing
the Branching slider will sometimes have no effect
and sometimes have a large effect.   Tweaking
Random Seed will sometimes create more branches
when Branching doesn't seem to have much effect.

Branch Spread
Controls how far apart the branches are spaced;
higher values increase the angle between branches.

Random Seed

Controls the random element in the creation of this
effect.  Minor changes in the Random Seed slider
can produce dramatic changes in your image, and
we encourage you to experiment with this control
until you find the effects you like best.  You will
then be able to precisely duplicate them by noting
the Random Seed setting.  Lightning has many
components based on random factors, so this
control is particularly important here.

Direction
Controls the angle at which the lightning crosses
your selection.  The blue oval indicates the general
direction at which the lightning will be aimed.

Inner and Outer Color
The glow at the middle of each bolt starts as the
Inner Color and fades to the Outer Color as it
moves outward.   Clicking in either box brings up
the color picker you have previously selected in
your graphics program.

Typical Lightning: short Segment Length; medium Jaggedness,
Glow Width, and Meander, high Branching and Branch Spread.

Lightning created with a dark Inner Color on a stone texture.

The lightning on the left has a Direction of 270 and the one on
the right has a Direction of 90.  Note that the Direction angle
specifies where the lightning is headed, not where it comes from.
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Little
Fluffy
Clouds

Little Fluffy Clouds creates a wide range of cloud
shapes and cloud-like effects, from slight wisps to
threatening storm fronts.   A wide range of plastic,
snow and liquid textures are also possible; we
recommend you explore the presets to see exactly
what this filter can do.

Controls

Puff Size
Controls the size of the cloud puffs created across
your selection; higher values yield larger and fewer
clouds.

Coverage
Higher values cover your image more completely
and smaller values leave more gaps in the clouds.

Edge Sharpness
Controls the sharpness of the clouds’ edges; lower
values yield softer, less defined clouds.

Base and Shadow Color
The clouds are made up of two colors.  Clouds are
the Base Color in high areas and fade to the
Shadow Color in low areas.  Clicking in either box
brings up the color picker you have previously
selected in your graphics program.
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Turbulent
Enabling this button creates a more windblown
effect which yields angrier clouds.

Random Seed

Controls the random element in the creation of this
effect.  Minor changes in the Random Seed slider
can produce dramatic changes in your image, and
we encourage you to experiment with this control
until you find the effects you like best.  You will
then be able to precisely duplicate them by noting
the Random Seed setting.

Surface Hardness
This slider governs how much the other lighting
controls affect your image.  If Surface Hardness is
set to 0, then the lighting controls in the right-hand
column of the preview window will have no effect
at all.  Setting Surface Hardness to a large value like
100 will allow you to create very strong shadows
and highlights with the lighting controls, produc-
ing some interesting, non-cloudlike textures.

Highlight Brightness and Highlight Sharpness
Control the white highlights that appear on those
parts of your selection facing the light.  Brightness
controls the intensity of these highlights, while
Sharpness affects their diffusion.  Higher values
yield a glossier effect.

Lighting Direction
Controls the direction from which the light falls on
your selection.  You have a full 360° range from
which to choose.  A value of 0° yields light directly
from the right; 90° yields light from the top; 180°
yields light directly from the left, and 270° yields
light from the bottom.

Lighting Inclination
Controls the angle formed by the light and the
page.  This gives he effect of more depth.  If the
light originates from directly overhead, the light
angle will be at 90°.  As the light comes more
directly from the side, the value will approach 0°.

Note that you can control the lighting by
clicking anywhere in the Lighting box or by
entering numeric values for Direction and
Inclination.

On left: Puff Size 40, 50% Coverage and Edge Sharpness of 50.
On right: the same settings, but with Edge Sharpness at 100.

Increasing the Surface Hardness yields a plastic effect.  On left:
low Puff Size.  On right: high Puff Size.
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Origami

Origami cuts your selection into small triangles and
then swaps the position of nearby triangles,
resulting in shapes reminiscent of folded paper.

Controls

Fold Size
Controls the length of the folds used to create the
triangles.

Random Seed

Controls the random element in the creation of this
effect.  Minor changes in the Random Seed slider
can produce dramatic changes in your image, and
we encourage you to experiment with this control
until you find the effects you like best.  You will
then be able to precisely duplicate them by noting
the Random Seed setting.
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Left to right: Original image, Origami applied with fold size of
8, Origami applied with a fold size of 23.

Orgami is applied to the lemon car above with a low fold size.
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Puzzle

Puzzle creates a jigsaw puzzle effect over your
selection, using highlights and shading.

Controls

Columns
Controls the number of vertical columns of pieces
drawn over the selection.  Higher values yield more
and smaller pieces.

Rows
Controls the number of horizontal rows of pieces
drawn over the selection.  Higher values yield more
and smaller pieces.

Bevel Width
Controls the width of the trench between puzzle
pieces.

Highlight Brightness and Highlight Sharpness
Control the white highlights that appear on those
parts of your selection facing the light.  Brightness
controls the intensity of these highlights, while
Sharpness affects their diffusion.  Higher values
yield a glossier effect.
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Lighting Direction
Controls the direction from which the light falls on
your selection.  You have a full 360° range from
which to choose.  A value of 0° yields light directly
from the right; 90° yields light from the top; 180°
yields light directly from the left, and 270° yields
light from the bottom.

Lighting Inclination
Controls the angle formed by the light and the
page.  This gives the effect of more depth.  If the
light originates from directly overhead, the light
angle will be at 90°.  As the light comes more
directly from the side, the value will approach 0°.

Note that you can control the lighting by
clicking anywhere in the Lighting box or by
entering numeric values for Direction and
Inclination.

Puzzle applied to a background area with a Bevel Width of 1
and with Horizontal and Vertical Pieces set to  10.

Puzzle applied in a layer with a high number of Columns and
Rows.  Only the opaque areas of the text are affected.

Puzzle was applied to an image and then a copy was put in a
new layer.  Pieces were selected and deleted in the top layer,
revealing the layer below.  The selection was inverted and then
used to delete pieces in the bottom layer.  The top layer was then
moved to the side.



36

Rounded

Rectangle

Rounded Rectangle creates a rectangle with
rounded corners just inside the edge of  your
selection.  The rectangle can have a 3-D bevelled
appearance or appear flat, and can be empty or
completely filled in.

Controls

Corner Radius
Controls how rounded the corners are; higher
values produce corners that take up more space.

Thickness
Controls the width of the rectangle’s border.

Solid Center
Enabling this button fills the rounded rectangle
with color.

Color
The Rounded Rectangle can be any color you like.
Clicking in the box brings up the color picker you
have previously selected in your graphics program.
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Surface Hardness
This slider governs how much the other lighting
controls affect your image.  If Surface Hardness is
set to 0, then the lighting controls in the right-hand
column of the preview window will have no effect
at all.  Setting Surface Hardness to a large value like
100 will allow you to create very strong shadows
and highlights with the lighting controls, produc-
ing a hard plastic effect, as well as other interesting
textures.

Highlight Brightness and Highlight Sharpness
Control the white highlights that appear on those
parts of your selection facing the light.  Brightness
controls the intensity of these highlights, while
Sharpness affects their diffusion.  Higher values
yield a glossier effect.

Lighting Direction
Controls the direction from which the light falls on
your selection.  You have a full 360° range from
which to choose.  A value of 0° yields light directly
from the right; 90° yields light from the top; 180°
yields light directly from the left, and 270° yields
light from the bottom.

Lighting Inclination
Controls the angle formed by the light and the
page.  This gives he effect of more depth.  If the
light originates from directly overhead, the light
angle will be at 90°.  As the light comes more
directly from the side, the value will approach 0°.

Note that you can control the lighting by
clicking anywhere in the Lighting box or by
entering numeric values for Direction and
Inclination.

Rounded Rectangle makes a quick, easy frame for any art.

Enable Solid Center to fill your rectangle with color.  High
Surface Hardness and Brightness yield a bevelled effect.

You can achieve a wide variety of effects by creating different-
sized Rounded Rectangles and transforming them in separate
layers.
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Shatter

Controls

Shard Size
Controls the size of the shattered mirror pieces.

Displacement
Controls the amount the image is offset from its
original position

Random Seed

Controls the random element in the creation of this
effect.  Minor changes in the Random Seed slider
can produce dramatic changes in your image, and
we encourage you to experiment with this control
until you find the effects you like best.  You will
then be able to precisely duplicate them by noting
the Random Seed setting.

Shatter creates an effect similar to that obtained by
looking at your selection in a broken mirror.
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Shatter applied to a layer of type with a small Shard Size and
low Displacement value.  A shadow was added to provide depth.

Shatter applied to the ‘S’ layer with a small Shard Size.  The top
of the ‘S’ has a low Displacement value.  The middle has a
medium Displacement value and the bottom has a high
Displacement value.  A shadow was added to provide depth.

The glass ball on the right was cut up and placed in different
layers.  Shatter was applied to each layer and the Displacement
was varied.  A shadow was added to provide depth.
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Shower Door

Shower Door is a distortion filter that simulates
viewing your image through lumpy glass, similar
to that found in many shower doors.

Controls

Dot Size
Controls the size of the distorting lumps of glass;
higher values produce larger amounts of distortion.

Random Seed

Controls the random element in the creation of this
effect.  Minor changes in the Random Seed slider
can produce dramatic changes in your image, and
we encourage you to experiment with this control
until you find the effects you like best.  You will
then be able to precisely duplicate them by noting
the Random Seed setting.
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Shower Door with low Dot Size.

Shower Door applied to the same image with increasing Dot
Size.
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Stain

Stain creates a realistic spilled liquid effect in the
shape of your selection.  Note that this filter was
designed to work with a selection; if you don’t
make a selection before applying Stain, the stain
will cover your entire image and the effect will not
be as noticeable.

Controls

Edge Width
Controls the width of the dark edge of the stain
inside your selection.  Higher values produce a
wider stain.

Irregularity
Controls the variability of the shape of the stain;
higher values produce a more uneven edge around
the stain.

Internal Opacity
Controls the transparency of the inner part of the
stain; higher values produce a more opaque stain.

Stain Color
The stain can be any color you like.  Clicking in this
box brings up the color picker you have previously
selected.
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Stain is applied to a white background with a selection in the
shape of the word “STAIN.” The Irregularity value is increased
with each version.

A circular border selection is made and Stain is applied with
medium Edge Width and Irregularity values.  A second, lighter
Stain is applied with  high Edge Width and Irregularity values.

The two dollar bill is selected.  A new layer is created and Stain
is applied to the new layer.  Select the transparency around the
Stain and delete the area around the bill.  The image is flattened
and a shadow is added for depth.
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Stamper

Stamper fills your image with miniature duplicate
tiles, creating a mosaic effect.  The image used for
the little tiles is called the stamp.  The image that
gets modified is called the original image.  The
stamp is usually a TIFF file that you choose, but can
be a copy of the original image.

The original image should be high resolution in
order to accommodate a large number of stamps
that are still recognizable.  Note that although the
original image should be large, it can be very poor
quality because most of its detail will be lost when
it is turned into stamps.  Both the original and the
stamp should contain a simple easily recognized
subject.

To choose the TIFF image, click on the white area
below the Use Original Image button.  The guide-
lines on the next page explain what type of TIFF
images can be used.

Controls

Stamp Width

Controls the width of the duplicate images used to
create the mosaic.  Higher values produce larger
and fewer stamps.

Use Original Image

When this button is enabled (i.e., the center is filled
with blue), Stamper will use a miniature version of
your current image as the stamp.

Stamp Source
When the Use Original Image button is disabled
(i.e., the center is empty), you can specify the
location of the TIFF file you’d like to use as your
Stamp Source.  Clicking in the white rectangle
brings up your computer’s Open dialog box, from
which you can choose the TIFF you’d like to use in
Stamper.
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Please note the following:

The TIFF should be created using Photoshop, and
can be in RGB, CMYK or Grayscale image mode,
but not in Lab image mode.

IMPORTANT:  the TIFF you are using as your
Stamp Source must be uncompressed.   To
uncompress a TIFF file, just open it in your
graphics program and Save it as a TIFF.  In
Photoshop, you will see a “TIFF Options” dialog
box.  Make sure the “LZW Compression” box is not
checked, and click “OK”.

Paint Shop Pro, Photo-Paint and other graphics
programs also offer the option to save a TIFF

without compression.  Please refer to your graphics
program’s manual for more information about
saving TIFF images in uncompressed form.

(Photoshop users please note: you must Flatten an
image before you can save it as a TIFF file.)

If, for any reason, the TIFF file for the Stamp Source
can not be loaded or is invalid, an error message
will be displayed explaining the problem.

Dali’s head was selected and feathered.  Use Original Image was disabled and a TIFF of Lincoln’s head was used.  Stamper
was applied with low Stamp Width.  The selection was then inverted and Stamper applied again with a high Stamp Width.
To increase detail, Dali’s eyes and mouth were copied to another layer, and a lower Stamp Width was applied to those areas.
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Television

Television makes your image appear as if it were
displayed on an old television.  A wide range of
video-like effects is possible.

Controls

Scanline Strength
Creates dark and light bands like those seen on old
television monitors; higher values yield stronger,
more visible bands.

Scanline Thickness
Controls the width of the dark and light bands;
higher values yield thicker and fewer bands.

Curvature
Simulates the distortion caused by curved picture
tubes; higher values increase the curvature.  If you
use a high Curvature setting on a selection in the
background layer, your background color will
show around the edges of your selection.  You can
avoid this by copying the image to its own layer
and applying Television there.
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Static
Controls the amount of visual noise added to the
image.  Higher values yield a more noisy and
colorful image.

Ghost Strength
Creates a faint, shifted copy of the image.  Higher
values produce a more obvious “ghost” copy.

Ghost Offset
Controls the amount the image copy is shifted from
the original; higher values yield “ghosts” farther
away from their original position.

Breakup
Adds random horizontal shifting to your image;
higher values yield a more wavy, broken-up image.

Television applied with medium Curvature to a background
layer, revealing the background color  around the edges.

Here’s a look at how some of the parameters affect an image
(clockwise from upper left): Breakup set at 35; low Scanline
Thickness; Static set at 50; Ghost Strength at 100 and Offset at
8.  In all four examples, Curvature is set to 26.

Television with Scanline Thickness, Curvature, Static, Ghost
Strength and Ghost Offset all set at high values.
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Troubleshooting

If you have trouble with any of the filters in
Xenofex, please read through this section.  We have
tried to collect the most commonly-asked questions
here.  A more up-to-date troubleshooting guide can
be found in the Support section at our website at
<http://www.alienskin.com>.  If you get really
stuck, the best way to get help is to send us
electronic mail at: <support@alienskin.com>.

Problem:  The filters do not appear in the Filter
menu.

Solution:  The filters were probably not installed in
your graphics program’s plug-in folder.  Find out
exactly which folder your host program is using for
plug-ins.  With Photoshop, you can determine this
by going to File->Preferences->Plug-ins.  Then try
to install the filters again and make sure you select
the proper plug-in folder by using the pop-up
menu at the bottom of the installation program.
Also, remember that after installing new filters, you
must restart your graphics program  for them to
become available.  If Mac users are still not seeing
Xenofex in the Filters menu, they should reinstall
Photoshop from the CD-ROM to restore any
possibly corrupt filter interface code.

Problem:  All or some of the filters appear grayed
out in the Filter menu.

Solution:  This will occur if you are using
Photoshop 5 and are trying to apply filters to type
before you have rendered the type layer.  Before
using a filter on type, make sure you have rendered
the type layer by choosing Layer>Type>Render
Layer from the menu bar.

Grayed-out filters in the Filter menu also occur if
you are in certain color modes that won’t allow a
specific filter to work properly.   See page 14 of this
manual for information about filters which only
work in certain modes.

Problem:  One of the filters seems to have no effect
on the image.

Solution:  This problem is usually due to the use of
extreme parameter settings.  Try lowering any very
large settings in the Preview window.  Also make
sure that the Preserve Transparency checkbox is
not checked for the layer that you are working
with.  Another possibility is that you have made
your selection in a mostly transparent part of a
layer and you are using a filter that does not affect
transparency.  Finally, you may have a layer
selected that is hidden behind other layers.

Problem:  I get a message that “Xenofex does not
have enough memory to render the preview. You
may be able to apply the effect to your image.
Please consult the Xenofex manual for ways to
increase the amount of memory available.” and my
preview window stops working.

Solution: Xenofex works within the memory
allocated to Photoshop. So if Photoshop’s memory
is being taken up by the image, the history palette,
etc. there may not be enough memory for Xenofex
to draw its preview. The solution is to exit our filter,
save your image and do the following steps…

For Windows: You can increase the memory
allocation by changing the Physical Memory Usage
percentage under File> Preferences> Memory in
Photoshop. You will have to restart Photoshop to
for the memory allocation increase to take place.

For Mac: You can increase the memory allocation
by exiting Photoshop and performing a Get Info on
the Photoshop program icon.

Problem:  The preview seems broken.  It only
shows the checkerboard pattern.

Solution:  Sometimes the preview begins in a
transparent part of a layer.  The simple solution is
to keep dragging the preview until you reach the
area of the layer that contains opaque image data.



49

Problem:  Preview is filled with color and I can’t
see the effects.

Solution:  Make sure that the Preserve Transpar-
ency checkbox is not checked on the layer that you
are affecting.

Problem:   Xenofex doesn’t work with a graphics
program that says that it uses Photoshop plug-ins.

Solution:  Just because a program says it uses
Photoshop plug-ins doesn’t always mean that we
are compatible with it.  Not every software com-
pany strictly follows the plug-in standard.  If you
have a question about using Xenofex with other
software, please visit our web site for the latest
compatibilityinformation.

Problem:  A filter makes the graphics program or
the entire computer crash or freeze up.

Macintosh Solution:  Make sure that you have
allocated enough memory to Photoshop.  The
default memory allocation may not be enough,
especially if you are working with print resolution
images.  You can increase the memory allocation by
exiting Photoshop and performing a Get Info on
the Photoshop program icon.

You might also have an extension conflict.  To
determine whether you have an extension conflict,
restart your computer while holding down the Shift
key.  You may release the Shift key after you see the
message “Welcome to Macintosh.  Extensions off.”
Then try the same filter operation.  If it now works,
then you have a control panel or extension installed
in your computer that is incompatible with
Xenofex.  We will love you very much if you try to
identify the problem extension and inform us about
the conflict.

Windows Solution:  Make sure that you have
allocated enough memory to Photoshop.  The
default memory allocation may not be enough,
especially if you are working with print resolution
images.  You can increase the memory allocation by
changing the Physical Memory Usage percentage
under File>Preferences>Memory in Photoshop.

Also, make sure that your computer system has the
minimum requirements to run our software.  You
should also try exiting out of other programs before
you run Photoshop, as there might be a conflict
between another program and Xenofex.  If you
notice such a conflict, we will love you very much
if you try to identify the problem program and
inform us about the conflict.

Problem:  All of the presets are gone except for
“Last Used.” How do I get the original presets
back?

Solution:  Missing presets indicate that the Xenofex
preference file has become corrupted or is not in the
proper location.  Xenofex looks for the preference
file (“Xenofex.INI” for Windows, “Xenofex Set-
tings” for Mac) in a certain location (for Windows,
in the Windows folder; for Mac, in the
System:Preferences folder).  If the file is missing or
corrupted, Xenofex will create a new preference
file.  To get the original presets back, delete the
current preference file and reinstall Xenofex.

Problem: How do I uninstall Xenofex?

Mac Solution: Find the Xenofex folder in your
graphics program’s plug-in folder and delete it.  Go
to your “System: Preferences” folder, and find and
delete the files “Xenofex Settings” and “Xenofex
Prefs”.

Windows Solution: Run Add/Remove Programs
from your Windows Control Panel.  Select
“Xenofex 1.0” from the Program list and click the
“Add/Remove” button.  This will remove the
program and its components.

Problem: How can I move my settings to the new
computer or hard drive?

Solution: For the Mac, look for “Xenofex Settings”
in the System: Preferences folder.  For Windows
machines, look for “Xenofex.ini” in your Windows
folder.  Make a copy of that settings file.  Install
Xenofex on your new machine or hard drive.  Copy
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the old settings file copy over the newly installed
settings file.

Windows Problem:  When I first bring up a filter,
some of the controls overlap.

Solution: Some video cards may initially draw the
Xenofex Preview window too small.  This can be
fixed by clicking the bottom right-hand corner of
the Preview window and resizing it.  You will only
have to do this once per filter; after that, the video
card will remember to draw the window correctly.

Windows Problem:  When I use some Xenofex
filters in Paint Shop Pro 4.15, I get strange results.

Solution:  Be sure to defloat your selection, using
Selections>Defloat or Ctrl-D, before applying
Electrify, Flag, Shatter, Crumple, Shatter, Distress,
Stamper or Television.  When you create Type or
Cut and Paste, Paint Shop Pro 4.15 will automati-
cally float your selection, and these filters behave
unpredictably on floating selections.
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Credits
O-Ring Technicians:  Jeff Butterworth, Finley Lee

Racing Stripe Painters:  Rumi Humphrey, Jim
Allman

Fluffers:  Dale Flattum, Sam Mauney

Warning Label Author: Todd Morman

Guinea Pigs:  Skip Elsheimer, Andy Spencer,
Amedeo Rosa

Pimps:  Scott Gilliam, Johnny Williams

Whores:  Michael Pilmer, J.B.  Popplewell

Smugglers:  Will Connor, Steve Graham

Telemarketers:  Susan Humphries, Jerry Pemberton

Mom:  Stef Maus

Untouchables:  Bill Thelen, Ben Hazard, Chad
Butterworth
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License Agreement
This is a legal agreement between you (either an individual or an entity), the end-user, and Alien Skin
Software LLC.  By installing the computer software in this package (“SOFTWARE”), by loading or running
the SOFTWARE, or by placing or copying the SOFTWARE onto your computer hard drive, you are agreeing
to be bound by the terms of this Agreement.  If you do not agree to the terms of this Agreement, promptly
return the SOFTWARE and the accompanying items (including all written materials), along with your
receipt to the place from where you obtained them for a full refund.

ALIEN SKIN SOFTWARE LLC LICENSE

1.  GRANT OF LICENSE.  Alien Skin Software LLC grants to you the right to use one (1) copy of the
enclosed SOFTWARE on a single computer.  For purposes of this section, “use” means loading the SOFT-
WARE into RAM, as well as installation on a hard disk or other storage device.  You may not:  rent, lease,
modify, translate, disassemble, decompile, reverse engineer, or create derivative works based upon the
SOFTWARE.  The SOFTWARE, together with any archive copy thereof, shall be either returned to Alien
Skin Software LLC or destroyed when no longer used in accordance with this Agreement, or when the right
to use the SOFTWARE is terminated.

2.  COPYRIGHT.  The SOFTWARE is owned by Alien Skin Software LLC and/or its licensors and is
protected by United States copyright laws and international treaty provisions.  You must treat the SOFT-
WARE like any other copyrighted material, except that you may either (a) make one copy of the SOFT-
WARE solely for back-up or archival purposes, or (b) transfer the SOFTWARE to a single hard disk pro-
vided you keep the original solely for backup or archival purposes.  You may not otherwise reproduce, copy
or disclose to others, in whole or in any part, the SOFTWARE.  You may not copy the written materials
accompanying the SOFTWARE.

3.  OTHER RESTRICTIONS.  This License Agreement is your proof of license to exercise the rights granted
herein and must be retained by you.  You may not rent or lease the SOFTWARE, but you may transfer your
rights under this License Agreement on a permanent basis provided you transfer this License Agreement,
the SOFTWARE, and all accompanying written materials and retain no copies, and the recipient agrees to
the terms of this Agreement.  Any transfer of the SOFTWARE must include the most recent update and all
prior versions.

4.  GENERAL PROVISIONS.  Should any provision of this Agreement be held to be void, invalid, unen-
forceable or illegal by a court, the validity and enforceability of the other provisions shall not be affected
thereby.  If any provision is determined to be unenforceable, you agree to a modification of such provision
to provide for enforcement of the provision’s intent, to the extent permitted by applicable law.  Failure of a
party to enforce any provision of this Agreement shall not constitute or be construed as a waiver of such
provision or of the right to enforce such provision.  If you fail to comply with any terms of this Agreement,
YOUR LICENSE IS AUTOMATICALLY TERMINATED.

LIMITED WARRANTY

LIMITED WARRANTY.  Alien Skin Software LLC and its licensors warrants that if properly installed and
operated on a computer for which it is designed, the SOFTWARE will perform substantially in accordance
with the accompanying written materials for a period of ninety (90) days from the date of receipt.

CUSTOMER REMEDIES.  Alien Skin Software LLC and its licensors’ entire liability and  your exclusive
remedy shall be, at Alien Skin Software LLC’s option, either (a) return of the price paid or (b) repair or
replacement of the SOFTWARE that does not meet Alien Skin Software LLC’s Limited Warranty.  To make a
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warranty claim, return the SOFTWARE to the point of purchase, accompanied by proof of purchase, your
name, your address, and a statement of defect, or return the SOFTWARE with the above information to
Alien Skin Software LLC.  This Limited Warranty is void if failure of the SOFTWARE has resulted in whole
or in part from accident, abuse, misapplication or violation of this Agreement.  Any replacement SOFT-
WARE will be warranted for the remainder of the original warranty period or thirty (30) days, whichever is
longer.  This warranty allocates risks of product failure between Licensee and Alien Skin Software LLC.
Alien Skin Software LLC’s product pricing reflects this allocation of risk and the limitations of liability
contained in this warranty.

NO OTHER WARRANTIES.  ALIEN SKIN SOFTWARE LLC AND ITS LICENSORS DISCLAIMS ALL
OTHER WARRANTIES, EITHER EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO, IMPLIED
WARRANTIES OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE WITH RESPECT
TO THE SOFTWARE AND THE ACCOMPANYING WRITTEN MATERIALS.  THIS LIMITED WARRANTY
GIVES YOU SPECIFIC LEGAL RIGHTS.  YOU MAY HAVE OTHERS WHICH VARY FROM JURISDICTION
TO JURISDICTION.  ALIEN SKIN SOFTWARE LLC AND ITS LICENSORS DO NOT WARRANT THAT
THE OPERATION OF THE SOFTWARE WILL BE UNINTERRUPTED, ERROR FREE OR MEET
LICENSEE’S SPECIFIC REQUIREMENTS.  THE WARRANTY SET FORTH ABOVE IS IN LIEU OF ALL
OTHER EXPRESS WARRANTIES WHETHER ORAL OR WRITTEN.  THE AGENTS, EMPLOYEES, DIS-
TRIBUTORS, AND DEALERS OF ALIEN SKIN SOFTWARE LLC ARE NOT AUTHORIZED TO MAKE
MODIFICATIONS TO THIS WARRANTY, OR ADDITIONAL WARRANTIES ON BEHALF OF ALIEN SKIN
SOFTWARE.  ADDITIONAL STATEMENTS SUCH AS DEALER ADVERTISING OR PRESENTATIONS,
WHETHER ORAL OR WRITTEN, DO NOT CONSTITUTE WARRANTIES BY ALIEN SKIN SOFTWARE
LLC OR ITS LICENSORS AND SHOULD NOT BE RELIED UPON.

EXCLUSIVE REMEDIES.  You agree that your exclusive remedy against Alien Skin Software LLC, its
affiliates, contractors, suppliers, and agents for loss or damage caused by any defect or failure in the
SOFTWARE regardless of the form of action, whether in contract, tort, including negligence, strict liability
or otherwise, shall be the return of the purchase price paid or replacement of the SOFTWARE.  This Agree-
ment shall be construed in accordance with and governed by the laws of the State of North Carolina.
Copyright and other proprietary matters will be governed by United States laws and international treaties.
IN ANY CASE, ALIEN SKIN SOFTWARE LLC AND ITS LICENSORS SHALL NOT BE LIABLE FOR LOSS
OF DATA, LOSS OF PROFITS, LOST SAVINGS, SPECIAL, INCIDENTAL, CONSEQUENTIAL, INDIRECT
OR OTHER SIMILAR DAMAGES ARISING FROM BREACH OF WARRANTY, BREACH OF CONTRACT,
NEGLIGENCE, OR OTHER LEGAL THEORY EVEN IF ALIEN SKIN SOFTWARE OR ITS AGENT HAS
BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES, OR FOR ANY CLAIM BY ANY OTHER
PARTY.  Some jurisdictions do not allow the exclusion or limitation of incidental or consequential damages,
so the above limitation or exclusion may not apply to you.

U.S.  GOVERNMENT RESTRICTED RIGHTS

The SOFTWARE and documentation are provided with RESTRICTED RIGHTS.  Use, duplication, or
disclosure by the Government is subject to restrictions as set forth in subparagraph (c)(1)(ii) of the Rights in
Technical Data and Computer Software clause at DFARS 252.227-7013 or subparagraphs (c)(1) and (2) of the
Commercial Computer Software—Restricted Rights at 48 CFR 52.227-19, as applicable.  Contractor/
manufacturer is Alien Skin Software, LLC, 1100 Wake Forest Road, Suite 101, Raleigh, NC  27604, USA.



The code for reading TIFF images in the Stamper filter comes from Sam Leffler.  Below is the permission
notice allowing us to use it.  Although he says his code can be used for free, we will hunt him down and
buy him a nice present.

Copyright (c) 1988-1996 Sam Leffler

Copyright (c) 1991-1996 Silicon Graphics, Inc.

Permission to use, copy, modify, distribute, and sell this software and its documentation for any purpose is
hereby granted without fee, provided that (i) the above copyright notices and this permission notice appear
in all copies of the software and related documentation, and (ii) the names of Sam Leffler and Silicon
Graphics may not be used in any advertising or publicity relating to the software without the specific, prior
written permission of Sam Leffler and Silicon Graphics.

THE  SOFTWARE IS PROVIDED “AS-IS” AND WITHOUT WARRANTY OF ANY KIND, EXPRESS,
IMPLIED OR OTHERWISE, INCLUDING WITHOUT LIMITATION, ANY WARRANTY OF MERCHANT-
ABILITY OR FITNESS FOR A PARTICULAR PURPOSE.

IN NO EVENT SHALL SAM LEFFLER OR SILICON GRAPHICS BE LIABLE FOR ANY SPECIAL, INCI-
DENTAL, INDIRECT OR CONSEQUENTIAL DAMAGES OF ANY KIND, OR ANY DAMAGES WHATSO-
EVER RESULTING FROM LOSS OF USE, DATA OR PROFITS, WHETHER OR NOT ADVISED OF THE
POSSIBILITY OF DAMAGE, AND ON ANY THEORY OF LIABILITY, ARISING OUT OF OR IN CONNEC-
TION WITH THE USE OR PERFORMANCE OF THIS SOFTWARE.





Alien Skin Software, LLC
1100 Wake Forest Road, Suite 101
Raleigh, NC  27604 USA
Voice: (919) 832-4124    Fax: (919) 832-4065

Email: support@alienskin.com
Web: http://www.alienskin.com
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